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Introduction 
In this section you’ll learn about: 

• Benefits of the LiveScribe Pulse Smartpen 
• LiveScribe Pulse Smartpen 
• LiveScribe DotPaper/Notebook 
• The Pattern 
• Controls 
• Initial Setup 

 
 
The LiveScribe Pulse Smartpen is a simple yet sophisticated piece of hardware that records audio and 
links it to what is written.  Did you miss what the professor said because he was talking too fast?  Tap on 
your notes or drawings with the tip of your Pulse Smartpen to hear what was said while you were 
writing. 
 
 

Benefits 
 
 

 No Need to Lug the Laptop: The LiveScribe Smartpen automatically captures everything as you 
write and draw.  

 
 

 Transfer your notes to your computer, organize them, and even search for  
words within your notes. Find what you want in seconds. 

 
 

 Upload your creations online for easy access from where ever you are.  
 
 

 The basic 2GB of memory can hold over 200 hours of recording. Actual time may vary due to 
audio quality settings. 
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LiveScribe Pulse Smartpen 

 
 

1. Power Button  
- The power button is located near the top of the Pulse Pen.  You can press it to turn on the 

LiveScribe Smartpen.  Holding it down for a few seconds will activate the quick recording 
feature recording.  

 

2. OLED Display  
- High contrast OLED display provides the pen a way to give the user feedback.  It can display 

menus, applications, games, and many other things. 
 

3. Built-In Microphone  
- The microphone combined with on-board noise cancelling software enables the Pulse to record 

sounds clearly. 
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4. Audio Jack  
- Connect the 3D recording headset and activate the enhanced far-field recording feature on the 

Pulse. Each of the ear buds has an embedded microphone. 
 

5. Built-In Speaker  
- Use the built-in speaker to play back your recorded audio or audio feedback for smartpen 

applications. 
 
6. Rechargeable Lithium battery 

- The rechargeable lithium Battery is non-removable and can only be charged via the USB Cradle. 
 

7. USB Connector  
- The USB Connector recharges the Pulse and transfers notes and audio to the computer as well as 

to install applications. The Smartpen is built so that it can dock magnetically into the USB 
Cradle. 

 

8. Infrared Camera  
- The infrared camera is built with the DPS (Dot Positioning System). This system tracks 

everything the user writes, taps or draw on the LiveScribe Dot Paper. The DPS enables printed 
controls for recording and playback on each page, and can also be used with interactive paper-
based applications. 

 

9. Replaceable Ink Cartridge  
- Used in conjunction with the USB Cradle, the user can easily replace the ink cartridges in the 

Pulse Smartpen. 
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LiveScribe Dot Paper/Notebook 

 
Magnified Sample of a LiveScribe Dot Paper  

 
LiveScribe’s special paper, called Dot or Digital paper is patterned paper designed to be used in 
conjunction with the Pulse pen to create handwritten digital documents.  
 
The printed dot pattern uniquely identifies the current page, total pages, and current position on the 
page. The digital pen uses this pattern to store what is written so it can be upload it to a computer. This 
special pattern is a patented dot positioning system licensed from Anoto. 
 
Note: Digital paper should not be confused with electronic paper. 
 
As of version 1.4 of the LiveScribe Desktop you can print your own dotted notepads on sheets of regular 
printer paper. The pages you print will work with your Pulse Smartpen in exactly the same way as any 
other sheet of LiveScribe dot paper. (See Printing Dot Paper on Page 40) 
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The Pattern 
Almost invisible to the naked eye, the Anoto pattern consists of numerous 
intelligent small black dots that can be read by a digital pen. In order to 
recognize where the user is writing on a page, the paper must be pre-
printed with a pattern of dots on a roughly 0.3 square mm grid. The dots are 
slightly offset from the grid to enable the infrared camera located near the 
writing tip of the pen to decipher where the pen is located on the page. 
Each page has a unique identity associated with it therefore allowing the 
pen to decode exactly which page you are writing on as well as which 
notebook the page belongs to and the total number of pages that the 
notebook contains.  

The Controls 
At the bottom of each page in the notebook is the Paper Replay Controls. 

 
 

1. NavPlus  
- The NavPlus is a 5-way navigator that enables you to navigate through the Smartpen main menu 

and application menus. 
 

2. Record/Pause/Stop Controls  
- These controls allow the user to start recording, pause recording/ playback and stop 

recording/playback. 
 

3. Jump Icons  
- The jump icons allow the user to skip backward or forward through the playback. 

 

4. Bookmark Icons  
- The bookmark icons allow the user to place a bookmark, go back to the previous bookmark, or 

go forward to next bookmark. Tapping the bookmark icon once places the bookmark, tapping it 
twice removes it. 

 

5. Audio Timeline Control  
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- The audio timeline control allows the user to skip to any part of the recording. 
 

6. Playback Speed Controls  
- The playback speed controls allow the user to adjust the reading speed.  You can decrease the 

speed, reset the speed to normal, or increase the speed. 
 

7. The Volume Control  
- The volume control allows the user to adjust to volume settings. You can decrease the volume, 

increase the volume or mute the sound. 

Initial Setup 
Upon the first startup of the smartpen you will need to run through the initial setup. 
 
Step 1 -  Press and hold the power button until the “LiveScribe” logo appears on the OLED, Let go of 

the power button and the Smartpen will start up. 
 

 
 

Step 2 -  After start up the OLED will display “Set Time”. 
 

 
 
Step 3 -  Open the LiveScribe Starter Notebook to the back of the front cover. This page contains the 

interactive icons for changing the settings. 
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Step 4 -  Using the LiveScribe Pulse Pen, tap on the clock icon labeled “Time” located on the back cover 
of the book in the “Status” box. 

 
 
Step 5 -  Tap on the “set time” icon on the left in the “Settings” box. A voice will say “set time” After 

tapping in the corresponding numbers to set the time a tone will alert you after you tap “AM/PM”. 

 
 

Step 6 -  Do the same for setting up the date. 
 
Other settings are available in the Settings tab such as: 

- Brightness 
- Scroll Speed 
- Volume 
- Left Handed/ Right Handed Configuration 

 
Keep in mind that if you want more information of a particular function on the interactive page, you can 
use the pen to tap on the “More Information” icon.  
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Smartpen Usage 
In this section you’ll learn about: 

• Basic Usage 
• Quick Recording 
• Paper Replay 
• Using the NavPlus 
• USB Mobile Cradle 

 

Step 1 -  Using the Pulse, tap the “record” icon , and then write 
 on the first line “The 3 main features” 

You will see a recording timer on the pen appear.  
 

Step 2 -  On the second line, write “#1 – the Pen and cradle” 
 

Step 3 -  On the third line, write “#2 – The Notebook or The NB” 
 

Step 4 -  On the fourth, write “#3 – The Desktop” 

Step 5 -  Using the Pulse Pen, tap the “Stop” icon . You have now  
 recorded your first session. 

Starting Quick Record (Audio Recording) 
Step 1 -  Turn on the Pulse Smartpen. 
 
Step 2 -  Press and hold the Power button for approximately five seconds until the display indicates that 

the recording started. 
 
NOTE: If your Smartpen is off, press and hold the Power button until the start sequence and the word 
“Recording…” appear on the display. Also, if you write on LiveScribe dot paper after starting recording 
with Quick Record, your Smartpen will link your notes and audio. Another way would be to double tap 
the NavPlus, tap down once, and then tap right. 

Paper Replay (Via Notebook) 
Using the Paper Replay function, your Smartpen records audio and links it to what you write. Later, you 
can tap on any of your notes and hear the audio recorded from that moment. Whenever you turn on the 
Pulse Smartpen, it captures a digital copy of your notes, whether or not you also choose to record audio. 
The Paper Replay control bar printed at the bottom of every notebook page lets you begin and end a 
recording as well as manipulate the playback of your recording.  
NOTE: The Paper Replay printed controls are not page-specific. You can tap Record on one page, begin 
recording, and then tap Stop on a different page and the Pulse Smartpen will stop recording. 
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Playing a Session 
There are 3 ways to playback your session. 
 
Tapping on your Notes  
Tap any note of the notes you wrote while you recorded using the Paper Replay™ application. The 
recorded audio will play back from the moment the notes were taken. During playback, your Smartpen 
display will indicate the current position in the recording and the time remaining in your recording.  

 
 

Tapping on Notebook Button 
Tap on any of the buttons located at the bottom of every notebook page. 

 Jump Forward/ Backward 
 

 Position button 
 

 Bookmark 
 
Using the NavPlus 
Step 1 -  Double-tap the center of the NavPlus to reach the main menu. 

 
 

Step 2 -  Tap down once on the NavPlus to reach the Paper Replay. 

  
 

Step 3 -  Tap right on the NavPlus, the first item is “Record New Session 

 
 

Step 4 -  Tap down to locate “Play Session” 

  
 

Step 5 -  Tap on the right arrow to view a list of sessions. 

 
 
From here you can scroll through the list by tapping “Down” arrow and then tap the “right” arrow on 
the NavPlus play that session. 
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The USB Mobile Cradle 
The Pulse Smartpen USB mobile charging cradle serves several important functions. Once you dock 
your Smartpen into the cradle, your written and recorded data will be automatically transferred to your 
computer after the LiveScribe Desktop application is opened. The cradle will also allow you to charge 
your Smartpen through the USB port on your computer.  
 

 
1. NavPlus – The cradle provides and alternate NavPlus that you can use to navigate your 

Smartpen’s options.  You can use it if you have no dot paper available or would prefer to not 
markup your paper. 
 

2. USB connector – The cradle connects to your computer using a standard USB connector.  The 
pen connects to the cradle using a simple quick connection.  The cradle holds the pen in place 
using a magnet located behind the connector. 

 
3. Ink Cartridge Removal Ring – The ink cartridge removal ring is used to remove the ink 

cartridge for replacement.   

3 

2 
1 
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Software Usage 
The LiveScribe Desktop is the software available for download that allows the user to transfer notes and 
recordings to the PC or Mac and play them back. Other functions include the built in search engine 
which allows the user to search through their handwritten notes quickly and easily. Upload their notes to 
the Online Community to share with other users, and also create flash videos of their notes, drawings 
and recordings. 
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Running LiveScribe Desktop 
To run LiveScribe Desktop: 

Step 1 -  On your desktop, double-click the LiveScribe Desktop shortcut ( ) or go to Start > 
Programs >LiveScribe > LiveScribe Desktop. 

 
* If you are upgrading from a pre-2.0 version, LiveScribe Desktop will migrate all existing LiveScribe 
data on your computer to a new format and location. This is necessary to support new and future 
features. 
 
** You will not be able to run LiveScribe™ Desktop 2.0 unless you complete the data migration 
process. 
 

 
 
Step 2 -  Connect your USB mobile charging cradle to your computer and dock your Pulse Smartpen to 

the cradle. Docking your Pulse Smartpen will transfer your notes and audio to LiveScribe Desktop 
automatically. Once you dock the Smartpen, do not remove it from the cradle until the transfer is 
complete.  

 
*Once completed, files from the pen, will be shown on the left and a prompt will come up* 
 
Step 3 -  When prompted, type a name for your Smartpen. This is the name that this computer and all 

other computers you link to will display when you dock and work with your Smartpen. 
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Step 4 -  If you have not registered your Pulse Smartpen with LiveScribe, LiveScribe Desktop will 
prompt you to do so. Once you register, you will be able to upload notes, install applications, and 
create a personal account on LiveScribe Online. 

Viewing Modes 
The LiveScribe Desktop has several ways of viewing your data from the Smartpen. 
Pages View is the default view when you run LiveScribe Desktop. You will use this view to look at 
pages in your notebooks. You can also playback the audio linked to your pages by clicking on green 
colored words or Active Ink. In Pages View, you can upload pages to your personal space on 
LiveScribe.com. In this view, you can view your notes either as single pages (Single-Page mode) or as 
thumbnails of multiple pages (Thumbnail mode). In Thumbnail mode, LiveScribe Desktop shows only 
pages with content as thumbnails. It displays empty pages as overlapping stacks of single blank pages. 
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In Audio View, you can view a list of your Paper Replay sessions. In this view, you can also play back 
recorded audio from your sessions, and upload sessions to your personal space on LiveScribe Online. 

 
 
LiveScribe Online is your connection to your personal web space and profile at LiveScribe.com. You 
can upload copies of your notes and recorded audio to LiveScribe Online to share with others. You can 
also use LiveScribe Online to manage your personal myLiveScribe space and access the LiveScribe 
Online Store. From the store, you can purchase LiveScribe Smartpen, notebooks, and accessories. You 
can also purchase additional applications for your Pulse Smartpen. 
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The Download Manager is for viewing applications you have downloaded from LiveScribe Online, 
including software updates and applications your have purchased from the LiveScribe Online Store. 
 

 

Panes and Tabs 
Central Viewing Pane 
The Central Viewing Pane is the central area where you view and interact with your notes. For 
example, this pane is where you view Pulse Smartpen content, such as notes and Paper Replay sessions. 
You can also play back Paper Replay sessions by clicking on your notes in this pane. 
 
Navigation Pane 
The LiveScribe Desktop provides a Navigation Pane on the left side of the Central Viewing Pane. The 
Navigation Pane lists items that you can navigate to or view in more detail in the Central Viewing Pane. 
For example, clicking one of the notebooks in the Navigation Pane opens the notebook and displays all 
of its pages as thumbnails. 
 
Using the Navigation Pane, you can view your library of notebooks, view pages that contain search 
results, and view active Paper Replay sessions and optionally upload them to your personal space on 
LiveScribe.com. The Navigation Pane uses tabs to organize its content. 
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Library Tab 
This tab shows your entire library of notebooks, journals, and other paper products you have used with 
your Pulse Smartpen. Use the Library tab to select which notebook you want to view in the Central 
Viewing Pane. 
 
Session Tab 
This tab shows all of the pages of a currently active Paper Replay™ session. This tab appears in the 
Navigation Pane when you activate a Paper Replay session, either by clicking an active ink on page, or 
by selecting a session in Audio View and viewing its pages in Pages View. 
 
Search Tab 
This tab shows the pages found using the Search feature. This tab shows the pages found with the search 
text highlighted in yellow. This tab appears in the Navigation Pane the first time you initiate a search. 
The tab's content refreshes during a search and holds one set of search results at a time. The results 
remain within the Search tab until you either initiate another search or close the tab. 

Binding/Registration 
A Pulse Smartpen that has been registered to a Master Email Account is “Bound” to that account as well 
as any other pens registered. 

To Register a Smartpen to the master account: 
Step 1 -   Load the “LiveScribe Desktop”.  
 
Step 2 -  Click on “Tools” 
 
Step 3 -  Click on “Smartpen” 
 
Step 4 -  Click on “Register” 
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Step 5 -  Enter your Master Email Address and Password, then click “Login” 
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Step 6 -  Fill out the information required. 

 
 
Step 7 -  Click on “Continue” 
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Step 8 -  Click “Submit” 

 
 
Step 9 -  You have now completed the registration or “binding” of the Smartpen to your Master 

    Email Account. 
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Managing Multiple Pens/ Unbinding 
After creating an account (a Master Email Account) you can then bind your first Pulse Smartpen (Look 
to: binding/unbinding). After completion, the pen will show up in the LiveScribe.com website on the 
bottom left under “My Pens”. You may then proceed to add additional pens. 

 
 
To remove pens simply click on the “unlink” button located under “My Pens” located on the bottom left. 
Please keep in mind that if you wish to bind the pen to the account again, you will have to use the 
LiveScribe Desktop. 

To completely remove a pen from an account: 
 If the person is available 
o Email/contact LiveScribe to change main email/ user name/ password 

 
 If the person is not available  
o Contact LiveScribe to change main user name/ email/ password  
o Provide contact info/ number 

 
http://www.LiveScribe.com/contact/index.html 

 LiveScribe Inc. 
7677 Oakport Street, 12th Floor 
Oakland, CA 94621 

 
 US Customer Service Phone: 

1-877-727-4239 or 510-567-4150 

 Customer Service Email:  
 

 CS@LiveScribe.com  
 

 Phone: Mon–Fri, 7am–7pm PT 
Email: 7 days a week 
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Pencasting 
Pencasting is the process of sharing your uploaded pages and audio recordings with others. 
You can share your notes as flash movies or as PDF files. You decide if you want to share the files with 
everyone, or with only specified recipients.  You can also share the content on Facebook or other social 
networks. 

Publishing notes and sessions to the Community (posting a 
Pencast) 
Access your LiveScribe Online profile and from ‘My Files’ in the right sidebar select the file you want 
to publish. 
 
Step 1 -  Start up the “LiveScribe Desktop” 
 
Step 2 -  Under “Library” highlight one of the Notebooks available. 
 
Step 3 -  Click on the available page(s) 
 
Step 4 -  Click on “Upload” 

 
 

Step 5 -  Fill out the Email User name/ Password 
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Step 6 -  You will see the following confirmation(s) 

 
 

 



LiveScribe Pulse Smartpen 

Presented by CATS Page 23 

 
Step 7 -  Click on “LiveScribe Online” located on the top right 

 
 
Step 8 -  Fill out the Email User name/ Password 
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Step 9 -  After logging in, you will see this page. (Locked Version) 

 
 
Step 10 -  By clicking on the locked icon located in the Sharing Preferences, you will have the file 

unlocked and viewed by all. (Unlocked Version). You have now started to Pencast. 
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Sharing Preferences 
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Access List 
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Application Store 
To access LiveScribe’s Application store 
 
Step 1 -  Start “LiveScribe Desktop” and click on “LiveScribe Online” located on the upper right. 

 
 
Step 2 -  Enter your Email Address/ Password and click on “Login” 
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Step 3 -  Once logged in, click on the “Store” tab located underneath “Pages” on the upper left.  

 

 

Purchasing/ Downloading an Application. 
The LiveScribe site is self explanatory in regards to purchasing or downloading an application for the 
LiveScribe Pulse. Please make sure that the LiveScribe Pulse is connected in order to install into the 
Smartpen, or you may choose to allow the download but install it later. 
 
Step 1 -  Select an Application to purchase. For this exercise we will select the “Classical Music 

Snippets” located at the bottom right in the “Top Free Apps” block then click “Add”. 
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Step 2 -  After clicking on “Add” the LiveScribe Desktop will take you to the “Shopping Cart” to 

complete the transaction. Just click on “Continue to Check Out” located on the bottom right. 
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Step 3 -  Fill in the required information, and then click on “Continue” located at the bottom right. Then 
on the next page click on “Place Order” 

 

 
 
Step 4 -  On this final page you may choose to print a copy of the transaction or download and install the 

application. 
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Step 5 -  After click on the “Download and Install Smartpen Applications” the Download Manager in 

The LiveScribe Desktop will automatically download and install to the Pulse Smartpen. 
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Step 6 -  If your Smartpen is docked, you will see the following on the pen. 

 

 
 
Applications in the Beta Store may only be purchased in: US/ UK/AU/CA.  
 
Smartpen and supplies ship only to the US. 

Hand Writing Recognition (MyScript for 
LiveScribe) 
LiveScribe’s partner, Vision Objects, is offering “MyScript for LiveScribe” text transcription software, 
which allows you to transcribe your handwritten notes into text. The software is available with 
LiveScribe Desktop for Windows version 1.4 or later for Mac version 1.1 or later. 
 
With MyScript for LiveScribe you can make edits to your converted text and even create a personal 
dictionary of frequently used words to ensure a more accurate conversion. The text can be copied and 
pasted into a variety of applications, including Microsoft Word and Outlook.  Vision Objects also 
provides some free additional recognition language downloads besides the default English version. 
  
MyScript for LiveScribe transcription software can be downloaded as a free 30-day trial or purchased 
for $29.95 at www.LiveScribe.com/vo. For support of the Vision Objects transcription software please 
open MyScript for LiveScribe and access "Help" and then "Contents".  You can also go to www.vo-
downloads.com/supportmyscript.  The software works best with neat and legible handwriting. 

To download the free trial version 
Step 1 -  Go to www.LiveScribe.com/vo then click and select the specific platform. 

To access MyScript 
Step 2 -  After Installation, launch the LiveScribe Desktop for Windows (version 1.4 or later). 
 
Step 3 -  On the left of the LiveScribe Desktop, in the “Library” Tab. Select the file you want to convert. 
 
Step 4 -  If you have multiple pages, “MyScript” can scan all or specify which page to scan. After 

selecting the file click the “Convert to Text” button in toolbar. 
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* When MyScript for LiveScribe opens, you may be prompted once to enter your Transcription 
Software Code / Activation code, if you don't have one, you can use the 30-day trial. 
 

 
 

Step 5 -  When MyScript opens, a conversion window will pop up. Click on “OK” and it will proceed to 
scan the file(s). 
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Step 6 -  After scanning the document for all handwritten text/images, it will show up on the panel on 
the right. 

 
 
 

Settings & Requirements 
System Requirements 

 Intel-based Mac with Mac OS X (10.5.5 or later, including 10.6) 
 Windows XP with SP3/Windows Vista/ Windows 7 
 600 MHz CPU or higher 
 300 MB minimum free disk space 
 Available USB 2.0 port 
 Internet connection 

Settings 
The LiveScribe Pulse Smartpen and the LiveScribe Desktop has various settings available to tweak. 
 
Pen Settings 
To access the “Settings” on the Smartpen: 
 
Step 1 -  Using the Pulse, tap on center of the “NavPlus” and you will see “Main  

 Menu” 
 
Step 2 -  Tap on the “Down” arrow 4 times to reach “Settings”  
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Step 3 -  Tap the “Right” arrow to access the features. 
 
 
 

 
 

In the settings of the Pulse, you can configure various features such as: 
 Recording Quality 
 Microphone Sensitivity 
 Playback Latency 
 Menu Voice 
 Display Brightness 
 Scroll Speed 
 Display Orientation 
 Date/ Time Format 
 Locale 

 
In each of the options listed above, tapping the “Right” arrow on the NavPlus will open addition 
configuration settings. 
 
Other Features on the Pulse Smartpen 
Other features available on the Pulse Smartpen can be accessed also by using NavPlus. The following 
can be accessed by tapping “Down” on the NavPlus and then tapping “Right” to activate the feature. 
 

 Paper Replay – allows basic recording/playback features 
 Piano – Play a piano! (Must be used with the Notebook) 
 Movies - 2 Movies built into the Pen 
 Translator Demo – Very basic demo of a Translator  

(Must be used with the Notebook) 
 
Configuring Settings for LiveScribe Desktop 
With the User Settings feature, you can set your preferences for LiveScribe Desktop application, the 
interaction of LiveScribe Desktop with the Smartpen, and how you want to display pages in LiveScribe 
Desktop. 
 
To set user preferences: 
Step 1 -  Go to Tools > User Settings 
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Step 2 -  Navigate through the tabs to set your preferences as described below. 
 
Application Settings 
Use the Application tab to set preferences for the LiveScribe Desktop application. Options include: 
 

 Keeping you logged in to LiveScribe Online when you launch LiveScribe Desktop 
 Specifying settings if your network uses a proxy server. Contact your system administrator for 

information about what settings to use. 
 Disabling the LiveScribe Desktop startup sound. 

 
 
Smartpen Settings 
Use the Smartpen tab to set preferences for your Smartpen. Options include: 

 Automatically installing applications and updates to your Smartpens instead of manually selecting 
which to install and where. 

 Enabling LiveScribe Desktop to show the library for a particular Smartpen by default on startup. 

 
Pages Settings 
Use the Pages tab to set preferences for how to display pages in LiveScribe Desktop. Options include: 
 

 Hiding blank (empty) pages when viewing thumbnails. 
 Choosing display colors for active ink (ink that has associated audio), inactive ink, and ink added 

to a session during audio playback. 
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Backing Up Your LiveScribe Data Folder 
 
LiveScribe recommends that you regularly back up LiveScribe Desktop files just like other important 
files on your computer. Backing up your files protects you from losing important files in case your 
computer becomes damaged, lost, or stolen. If you later need to restore your LiveScribe Desktop files, 
contact LiveScribe Customer Service for instructions.  
 
You can find all files associated with LiveScribe Desktop in your LiveScribe folder. This folder contains 
your notes and audio, as well as important information about your Pulse Smartpen and LiveScribe 
Desktop. By default, LiveScribe Desktop creates the LiveScribe folder in these locations: 
 
For Windows XP: 
 
C:\Documents and Settings\your windows account name\Local Settings\Application Data\LiveScribe 
 
NOTE: By default, Windows hides the Local Settings folder. Refer to your Windows documentation on 
how to enable the “show hidden files and folders” option for your Documents and Settings folder. 
 
For Vista and Windows 7: 
 
C:\Users\your_windows_account_name\AppData\Local\LiveScribe 
To back up your LiveScribe folder: 
Step 1 -  Exit LiveScribe Desktop. 
 
Step 2 -  Locate your LiveScribe folder. 
 
Step 3 -  Copy the folder to a backup device, such as a CD, DVD, or external drive. 
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Troubleshooting & Tips 
In this section, we have listed some of basic troubleshooting information and tips. 

Printing Dot Paper 
To print your own notepads using the LiveScribe Desktop you will need a Color LaserJet Printer that is 
Adobe PostScript compatible and can print at 600dpi or higher. Printing your own notepads to a non-
PostScript printer may cause LiveScribe Desktop to be unresponsive and require a restart 
 

 - Printable notepads (Desktop) 
o 25 page limit (4 books/ 100pgs total) via desktop 
o Can’t be copied due to the fact that each page has an identity of its own and would duplicate 

if it was photocopied. Ex: page 1 copied 5 times. Each time used the page one will repeat on 
every page one. 

Step 1 -  Go to LiveScribe.com 
 
Step 2 -  Click on "smartpen" tab (located on upper left) 
 
Step 3 -  Click on "LiveScribe Desktop" 
 
Step 4 -  On the right, click and download for your OS 

The Pulse is not turning on 
If this is a new Pulse Smartpen and you are unable to turn it on by pressing the power button, your 
Smartpen may need to be charged for a short while before using it. 
 
Charge the Smartpen for 10-15 minutes before removing it from the cradle in order to go through the 
“Getting Started Guide” as well as the Starter notebook introduction pages “Paper Replay Basics” and 
“The NavPlus Navigation Basics” 
 
For a full battery charge, leave the Smartpen in the cradle for 2.5 hours. 
 
There are two ways to charge your Smartpen: 
 
USB AC Wall Adapter 
If you purchased a separate USB AC Wall Adapter, plug it into a wall outlet. 
Computer 
If you do not have a USB AC Wall Adapter then download the LiveScribe Desktop software by visiting 
www.LiveScribe.com select the LiveScribe Desktop installer for your operating system. 
  
During the installation Windows users will be prompted to plug the charging cradle into a USB port on 
the computer and to dock the Smartpen.  
*Mac users do not get this prompt but should wait until the software is installed* 
 
Remove the USB charging cradle from the box, remove the warning label and place your Smartpen on 
the charging cradle dock. 
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Within a few minutes the Smartpen OLED display will light up and the shapes of a battery and a 
lightning bolt will appear.  This indicates the battery is charging. 

The Pulse is not Charging 
If the Pulse Smartpen’s OLED display does not light up and display the shapes of a battery and a 
lightning bolt when sitting on the charging cradle, try the following: 
 
Step 1 -  Make sure your cradle is plugged into a USB port directly on your computer, not a USB hub. 
 
Step 2 -  When you dock your Pulse Smartpen by placing it in the cradle, please make sure the magnet 

locks it in place. The Smartpen display should light up. 
 
*If your Smartpen display does not turn on when docked to the charging cradle, the USB port is not 
providing power so there is a problem with that USB port. Try plugging the charging cradle into each of 
your USB ports on your computer and monitor (if any). 
 
*If the display lights up, leave the Pulse Smartpen in the charging station for 2.5 hours for a full charge. 
Afterwards your Smartpen should function as normal. 
 
Step 3 -  If the Pulse Smartpen still won’t power on and charge while docked, try cleaning the contacts 

on the cradle and Smartpen. To do so, take an eraser and rub the end on a blank area of paper to 
make sure it is completely clean. 

 
Without applying downward pressure that might bend the contacts, gently rub backwards (towards the 
NavPlus) and forwards (towards the cable end) on the surface of the four metal contacts the cradle uses 
to connect with the Pulse Smartpen. 
 
Rub the eraser end on a blank area of paper to clean it again. 
 
To clean the Smartpen contacts, in a circular pattern gently rub the four metal contacts the Smartpen 
uses to connect with the cradle. 
 
If you have never been able to charge the Pulse Smartpen using the charging cradle or still have an issue 
with the Smartpen not charging but it was charging before, contact LiveScribe (www.LiveScribe.com) 

Operating Systems that LiveScribe Desktop is compatible with 
Mac Version 
Mac Leopard OS official releases 10.5.5 or higher (for Intel based Macs only). 
 
Windows Version 
Windows 7 64-bit and 32-bit Home Premium, Professional, Ultimate, and Enterprise as Standard User 
and Administrator 
 
Windows Vista 64-bit and 32-bit Home Basic, Home Premium, Business, and Ultimate (no Service Pack 
required) as Standard User and Administrator   
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Windows XP 32-bit with Service Pack 3 as Standard User and Administrator using LiveScribe Desktop 
version 1.6 or higher (Windows XP 64-bit is not supported). Older versions of LiveScribe Desktop 
require Administrator rights or the Pulse Smartpen will not be recognized by the LiveScribe Desktop. 

What audio format does the LiveScribe Desktop save files in? 
LiveScribe Desktop uses the popular Advanced Audio Coding (AAC) file format when saving Pulse 
Smartpen recordings for playback using LiveScribe Desktop.  The files can also be exported from 
LiveScribe Desktop and played by other media applications.  

How do I export to other audio formats using Windows 
LiveScribe Desktop? 
Using Windows LiveScribe Desktop you can easily export your audio files in order to play or share 
them outside of LiveScribe Desktop. 
 
Step 1 -  Open LiveScribe Desktop. 
 
Step 2 -  Click the “Audio” button in the top left or choose “Navigation > Audio” from the Menu. This 

opens the Audio View and brings up a list of all sessions. 
 
Step 3 -  Select the Paper Replay ™ recording that you want to export. 
 
Step 4 -  Right-click, or from Menu select “File” and then select “Export Audio...” 
 
Step 5 -  Select the audio file format you would like to export to: 
 

 To AAC… 
 To M4A… 
 To MOV… 
 To MP4… 
 To WAV… 

 
Step 6 -  The “Save Audio” dialog will open. Input the output file’s path and name, or accept the default. 
 
NOTE: The AAC, M4A, MOV, and MP4 formats are available as long as the session is recorded in 
mono only (using the Smartpen microphone) or stereo only (using the headset microphones). A mixed 
session (one session recording started with the headset plugged in and the headset is removed before the 
recording ends, or a session started without the headset plugged in but the headset is plugged in before 
the recording ends) can only be saved in the WAV format. 
 
Step 7 -   “Save”. Your audio file is saved to the specified location. 
 
Step 8 -  To listen to your exported file, double click the file or drag it into an audio player application 

that supports the file type you exported. 
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How do I print my own notepads using Windows LiveScribe 
Desktop?  
Step 1 -  Open LiveScribe Desktop. 
 
Step 2 -  From the top Menu select the “Tools” menu option. 
 
Step 3 -  Choose “Printable Notepads” and then “Test Page (1 Page)…” 
 
Step 4 -  If not already displayed, select the PostScript LaserJet printer from the dropdown list. 
 
Step 5 -  Click “Print”. 

How do I replace the Ink Cartridge? 
Step 1 -  Insert you Smartpen ink tip into the ink cartridge removal ring. 
 
 
 
Step 2 -  Tilt your Smartpen so that it firmly rests against the removal ring.  
 
 
 
 
Step 3 -  Pull the Smartpen straight up. 
 

Trouble Purchasing and Transferring Apps 
Not sure if the application was downloaded/Do not know how to transfer it to the 
Smartpen. 
Step 1 -  Open LiveScribe Desktop. 
 
Step 2 -  Dock the Smartpen you would like the application to transfer to. 

 
*If you are not the registered owner of the Smartpen that is docked you will not be able to transfer 
the application to that Smartpen. If this is the case, remove that Smartpen and dock one that you are 
the registered owner of. 

 
Step 3 -  In the upper right click on the “Application Manager” button. 
 
Step 4 -  If your application shows under the “Application Name” column, look under the “Transfer” 

column for “To Smartpen” or “From Smartpen”. 
 
Step 5 -  If the “To Smartpen” button appears then click it to get the application to transfer to your 

Smartpen. 
 
* If “From Smartpen” appears then the application already transferred to the Smartpen that is docked.  



LiveScribe Pulse Smartpen 

Presented by CATS  Page 42 

  
Step 6 -  The application can be accessed by undocking the Smartpen 
 
Step 7 -  Double-tap the center of a NavPlus located at the bottom left corner of any notebook page. 
 
Step 8 -  Tap the down-arrow to get to “Applications”  
 
Step 9 -  Tap the right-arrow to access the Applications list. 
 
Step 10 -  Tap the down-arrow to Scroll down until you see your application. 
 
*If your application does NOT show up under the “Application Name” column in the LiveScribe 
Desktop “Application Manager” window, click on the “Download Manager” tab on the left side of the 
window. 
 
If the application does NOT show up in the “Download Manager” tab under the “Name” column then 
the purchase did not complete and you will need to go back to the online Store to complete the 
transaction. 
 
If you received an email confirmation that the order went through then you may have purchased the 
application using an email address that is different from the one your Smartpen is registered under.  

An Application is not transferring to Smartpen from Windows LiveScribe Desktop. 
If an application you purchased appears in the Windows LiveScribe Desktop “Download Manager” tab 
but does not appear in “Application Manager”, or the application appears in “Application Manager” but 
clicking “To Smartpen” does nothing even though the Pulse Smartpen is docked, you will need to 
rename 2 LiveScribe file to solve this issue. 
 
Make sure that the hidden folders options have been set to be unhidden. 
 
Step 1 -  Access the database folder: 
 

a) Right-click on the Windows “Start” button. 
 

b) Select “Explore”. 
 
Windows XP users navigate to: 
C:\Documents and Settings \your_windows_account_name\Local Settings\Application 
Data\LiveScribe\Desktop\Data 
 
Windows 7 and Vista users navigate to: 
C:\Users\your_windows_account_name\AppData\Local\LiveScribe\Desktop\Data 

 
Step 2 -  Right-click on the “FileItems.EDB” file, select “Rename” and change the name to 

“FileItems2.EDB”. 
 
Step 3 -  Right-click on the “DownloadManagerItems.EDB” file, select “Rename” and change the name 

to “DownloadManagerItems2.EDB”. 
 
Step 4 -  Dock your smartpen if it isn’t docked already. 
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Step 5 -  Run LiveScribe Desktop. 
 
Step 6 -  When the LiveScribe Downloads window open click the “Download” button to download all of 

the selected applications once more. 
 
Step 7 -  You should see the applications appear in “Application Manager”. 
 
Step 8 -  If the applications don’t start transferring automatically, click the “To Smartpen” button to start 

the transfer of each one. 

Unable to login using LiveScribe Desktop (Error Message Pops 
Up) 
 

 
 

Step 1 -  Find out which version of the firmware that is on the Pulse and on the LiveScribe 
 Desktop. 
 
To find out the version on the LiveScribe Smartpen: 
 
a) Using the pen, double tap the center of the SmartNav, and then write the letter “v” in the 

notebook. 
 
*Alternately, on the newer notebooks, you can use the pen and tap on the software version icon 
in the interactive icons panel. 

 
Step 2 -  In the LiveScribe Desktop, just click on “help” then click “about”. A new window will pop up 

with the software version. 
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* The current working version that LiveScribe recommends is (Desktop) version 2.1 and (Pulse) 2.2 
 
Step 3 -  Log into your account 
 
Step 4 -  Visit the LiveScribe website (www.LiveScribe.com) then click on the “Community” tab.  
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Step 5 -  Click on the Accounts tab and click the Login button located in the upper right.  

 
 

 
 
 
Step 6 -  After logging in, log out. 
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Step 7 -   Make sure hidden folders are visible.  To do so: 
a)  XP users:  

Click on the Windows “Start” button, click “Control Panel, double-click “Folder Options” and 
select the “View” tab. 
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b) Windows 7/Vista users:  
Control Panel Home view - Click on “Appearance and Personalization” and select “Show 
Hidden Files or Folders”. (Make sure you are in Classic View to change, look to the upper left 
side of the Control Panel and click “Switch to Classic View”) 
Double-click “Folder Options” and select the “View” tab. 
Under the “Hidden files and folders” section, if not already selected, select the radio button 
labeled “Show hidden files and folders” and click “OK”.  

 



LiveScribe Pulse Smartpen 

Presented by CATS  Page 48 

 
 

 
 

Step 8 -  Now you can access the database folder.  To do so: 
 

a) Right-click on the Windows “Start” button. 
 

b) Select “Explore”. 
 
Windows XP users navigate to: 
C:\Documents and Settings \your_windows_account_name\Local Settings\Application 
Data\LiveScribe\Desktop\Data 
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Windows 7 and Vista users navigate to: 

 
C:\Users\your_windows_account_name\AppData\Local\LiveScribe\Desktop\Data 

Step 9 -  Right-click on the “System.EDB” file, select “Rename” and change the name to 
“System2.EDB”. 

 
Step 10 -   Run LiveScribe Desktop and you should get the prompt “Please log in so LiveScribe Desktop 

can access your store account and any available downloads” 
 
Step 11 -  Click “OK” and select the “Use my existing account” radio button. 
 
Step 12 -  Login and register your smartpen with your previously registered email address.   If you do 

not recall your password select the “Forgot Password” button to reset your password. 

 
 
After you log in and confirm your registration information you should no longer get an error message 
when you dock your smartpen. 

Updating the pen 
If the LiveScribe desktop does not automatically update the Pulse: 
Step 1 -  First do a hard reset. 
 

a) Press and hold the power button for 10+ seconds. Your smartpen will restart in a recording 
session and will turn off again. It will then restart with the message “LiveScribe… Starting… 
Checking file system”. 

 
Step 2 -  After the hard rest has been completed, connect the pen to the USB Dock and open LiveScribe 

desktop. 
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Step 3 -  Wait a few moments and click on the “applications manager” in the upper right and click on the 

“Download Manager” tab on the mid left side of the panel. 
 
Here you will be able to see what version is currently being downloaded, installed or being installed. 

 
 
Another of resetting the pen and updating it to the latest version it to contact us (CATS) and a file w/ 
instructions will be sent by email. 



LiveScribe Pulse Smartpen 

Presented by CATS Page 51 

LiveScribe Pulse & Care and Maintenance 
The Pulse Smartpen may be damaged by improper handling or storage. Do not drop, throw, bend, crush, 
deform, puncture or open the Pulse Smartpen. Failure to follow these instructions could result in electric 
shock, fire, personal injury, property damage or damage to your Smartpen, as well as voiding your 
limited warranty. It is also essential that you take proper care of the Pulse Smartpen to ensure its 
durability. Here are our guidelines: 
 

 Do not drop your Smartpen or allow any other kind of strong impact, which can severely damage 
it or prevent it from working properly. 

 
 Do not place your Smartpen in any area where it could be crushed (i.e. back pocket, bottom of 

backpack, etc.) 
 

 Do not store your Smartpen in extreme high or low temperatures. Store it in a cool, dry place. 
 

 Do not expose your Smartpen to water or any other liquids. It is not waterproof or water resistant. 
Do not leave it in damp conditions. 

 
 Do not dispose of your Smartpen in a fire, as the battery may explode or ignite. 

 
 Only use LiveScribe-approved ink cartridges. 

 
 Store your Smartpen in its protective case when not in use. 

 
 Use a soft cloth for general cleaning. 

 
 Transfer your important notes and Paper Replay sessions from your Smartpen to your LiveScribe 

Desktop often so that you have a backup copy on your computer. Also, backup your computer’s 
files regularly. 

 
 Keep your Smartpen charged. 

 
IMPORTANT: Do not attempt to charge your Smartpen via any other means other than the USB 
mobile charging cradle provided in the box with your Smartpen or the Pro Charging Cradle accessory 
WARNING: FAILURE TO FOLLOW THESE SAFETY INSTRUCTIONS COULD RESULT IN 
FIRE, ELECTRIC SHOCK, OR OTHER INJURY OR DAMAGE. 
 
 


	Introduction
	Benefits
	LiveScribe Pulse Smartpen
	LiveScribe Dot Paper/Notebook
	The Pattern
	The Controls
	Initial Setup

	Smartpen Usage
	Starting Quick Record (Audio Recording)
	Paper Replay (Via Notebook)
	Playing a Session
	The USB Mobile Cradle

	Software Usage
	Running LiveScribe Desktop
	Viewing Modes
	Panes and Tabs
	Binding/Registration
	To Register a Smartpen to the master account:

	Managing Multiple Pens/ Unbinding
	To completely remove a pen from an account:


	Pencasting
	Publishing notes and sessions to the Community (posting a Pencast)
	Sharing Preferences
	Access List

	Application Store
	Purchasing/ Downloading an Application.

	Hand Writing Recognition (MyScript for LiveScribe)
	To download the free trial version
	To access MyScript

	Settings & Requirements
	System Requirements
	Settings
	Backing Up Your LiveScribe Data Folder

	Troubleshooting & Tips
	Printing Dot Paper
	The Pulse is not turning on
	The Pulse is not Charging
	Operating Systems that LiveScribe Desktop is compatible with
	What audio format does the LiveScribe Desktop save files in?
	How do I export to other audio formats using Windows LiveScribe Desktop?
	How do I print my own notepads using Windows LiveScribe Desktop?
	How do I replace the Ink Cartridge?
	Trouble Purchasing and Transferring Apps
	Not sure if the application was downloaded/Do not know how to transfer it to the Smartpen.
	An Application is not transferring to Smartpen from Windows LiveScribe Desktop.

	Unable to login using LiveScribe Desktop (Error Message Pops Up)
	Updating the pen

	LiveScribe Pulse & Care and Maintenance

